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English 

Set Resolution Utility
The Set Resolution utility allows the user to select the screen resolution, the use of large and normal 
fonts, and, in some instances, the number of simultaneous screen colors. In addition, certain graphics 
chips and custom video display driver configurations support mouse pointer trails and/or landscape or 
portrait viewing orientations.

For information on how to use Help, press F1 or choose Using Help from the Help Menu.
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Exit Menu
Help Menu
Features

International Help



Exit Menu
The Exit menu includes a command that immediately exits the Set Resolution utility.    If a selection has 
been modified or if the custom video display driver has not yet been installed, the user will be prompted to
either restart Windows immediately or continue with the current Windows session.    If the restart option is 
selected, Windows will attempt to terminate all tasks and immediately restart using the new resolution 
selections.    If the restart option is not selected, the Set Resolution utility will terminate.    The new 
resolution selections will take effect the next time Windows is started.

Index



Help Menu
The Help menu includes commands that invokes a Help session and displays the hardware and display 
driver environment.

For more information, select the Help menu command name.

About Shows information about the Set Resolution Utility.

Help Retrieve the Help Window for the Set Resolution utility
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Set Resolution Features 

The Set Resolution utility feature set allows the user to select the screen resolution, the use of large and 
normal fonts, and, in some instances, the number of simultaneous screen colors.

Mouse pointer trails and landscape/portrait viewing orientation are determined by the graphics chip set 
and the available custom video display drivers.

Enabling or disabling the mouse pointer trails function on devices which support the mouse trails option 
will have immediate results.    All other selected options are enabled the next time Windows is restarted, 
as discussed below.

The custom video display drivers are capable of supporting various combinations of screen resolutions 
and simultaneous colors.    The maximum resolution and number of simultaneous colors are determined 
by the graphics chip set, the amount of installed video memory, the monitor type, and the available 
custom video display drivers.

The custom video display drivers allow versions of Windows release 3.1 and above to utilize large or 
normal fonts.    Large fonts utilize screen resources of 120 dots per inch (dpi).    Small fonts utilize screen 
resources of    96 dpi.    The use of 120 dpi rather than 96 dpi resources will increase the physical size of 
the Windows system resources.    In order for the large fonts option to be selectable, the large font 
resources must have been installed in the Windows system directory.    This is usually accomplished while
installing video drivers using the Windows Setup program.    The large font resources, sometimes referred
to as the Windows 8514 fonts, must have been previously installed.    Windows release 3.0 does not 
provide the ability to change the screen or font resources.

Selecting the Cancel button from the utility's main window will immediately terminate the Set Resolution 
session.    Any selections will be disregarded.

Selecting the OK button from the utility's main window will immediately terminate the Set Resolution 
session if no modifications have been made.    If one or more modifications have been changed the user 
will be prompted to either restart Windows immediately or continue with the current Windows session.    If 
the restart option is selected, Windows will attempt to terminate all tasks and immediately restart using 
the new resolution selections.    If the restart option is not selected, the Set Resolution utility will terminate.
The new resolution selections will take effect the next time Windows is started.

If the custom video display driver has not yet been installed as the Windows display driver and the OK 
button is selected from the utility's main window or Exit is selected from the File Menu, the user will be 
prompted to either immediately restart Windows or continue with the current Windows session.    If the 
restart option is selected, Windows will attempt to terminate all tasks and immediately restart using the 
custom video display driver.    If the restart option is not selected, the Set Resolution utility will terminate.    
The custom video display driver will be used the next time Windows is started.
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Help 

Choosing the Help command from the Help menu will invoke the Windows' Help utility.
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About
Choosing the About command from the Help menu displays information about the Set Resolution utility.
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Italiano

Programma Utillitario SetRes
Il programma utilitario SetRes permette di scegliere la risoluzione dello schermo, luso di fonti normali o 
grandi. e, in alcuni casi, il numero di colori che appaiano simultaneamente sullo schermo. Inoltre, alcuni 
chip grafici e configurazioni personalizzate del driver video supportano le funzioni di tracciamento del 
puntatore del mouse e/o un orientamento orizzontale o verticale della visualizzazione.

Per informarsi del uso della facilita Aiuto. premete il tasto F1 o scegliete Aiuto dal Menu

Voci

Menu Esci
Menu    Aiuto ?
Funzioni

Aiuto Internazionale



Menu Esci
Il menu Esci include un comando che consente di uscire immediatamente dal programma Set Res. 
Qualora l'utente abbia modificato una selezione o se il driver video personalizzato non è stato ancora 
installato, il programma richiede all'utente se desidera riavviare subito Windows o continuare la sessione 
di lavoro corrente. Se si seleziona l'opzione di riavvio, Windows termina tutti i compiti (task) correnti e si 
riavvia immediatamente utilizzando le nuove selezioni di risoluzione. In caso contrario,    il programma 
SetRes viene terminato e le nuove selezioni di risoluzione verranno applicate la volta successiva che si 
avvia Windows.
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Menu    Aiuto ?
Il menu ? include comandi che consentono di richiamare una sessione della Guida e di visualizzare 
l'ambiente di driver hardware e video.

Scegliete dal Menu ? il comando Aiuto per ottenere ulteriori informazioni.

Info Mostra Informazioni riguardo il programma SetRes

Aiuto ? Apre la finestra delAiuto per il programma SetRes
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Funzioni del programma SetRes
Il set di funzioni del programma SetRes consente all'utente di selezionare la risoluzione dello schermo, 
l'uso di font grandi o normali e, in alcuni casi, il numero di colori che appaiono sullo schermo 
simultaneamente.

La disponibilità delle funzioni di tracciamento del movimento del mouse sullo schermo e di orientamento 
verticale/orizzontale della visualizzazione dipende dal set di chip grafici e dai driver video personalizzati 
disponibili.

L'abilitazione e la disabilitazione della funzione di tracciamento del puntatore del mouse su dispositivi che
supportano tale funzione verranno immediatamente applicate, mentre tutte le altre opzioni selezionate 
vengono abilitate la volta successiva che si avvia Windows, come sotto illustrato.

I driver video personalizzati sono in grado di supportare varie combinazioni di risoluzioni dello schermo e 
di colori vedutti simultaneamente sullo schermo. La risoluzione massima ed il numero di colori visibili 
contemporaneamente dipendono dal set di chip grafici, dalla quantità di memoria video installata, dal tipo 
di monitor e dai driver video personalizzati disponibili.

I driver video personalizzati consentono di utilizzare font grandi e normali con Windows 3.1 e versioni 
successive. I font grandi utilizzano 120 punti per pollice (dpi) delle risorse dello schermi, mentre i font di 
dimensioni ridotte utilizzano 96 dpi. L'uso di 120 dpi invece che di 96 dpi aumenta la dimensione fisica 
delle risorse di sistema di Windows. Affinché l'opzione Font grandi sia disponibile, occorre aver installato i
relativi file di risorse nella directory di sistema di Windows. Tale operazione viene normalmente eseguita 
mentre si installano i driver video con il programma Setup di Windows. Occorre aver prima installato le 
risorse dei font grandi, a volte detti anche font 8514 di Windows. La versione 3.0 di Windows non 
consente di cambiare le risorse di schermo o i font.

Per terminare la sessione di SetRes senza applicare le eventuali opzioni impostate, selezionare Annulla 
dalla finestra principale dell programma.

Selezionando il pulsante OK senza nessuna modifica, chiude immediatamente la sessione di SetRes. Se 
avete compiuto delle modifiche, il programma vi richiede se desidera riavviare subito Windows o 
continuare la sessione di lavoro corrente. Se si seleziona l'opzione di riavvio, Windows termina tutti i 
compiti correnti e si riavvia immediatamente utilizzando la nuova selezione di risoluzione. In caso 
contrario, il programma SetRes termina e la nuova selezione di risoluzione verra applicata la prossima 
volta che si avvia Windows.

Se il driver video personalizzato non è ancora stato installato come driver video di Windows e si preme il 
pulsante OK dalla finestra principale della utility oppure l'opzione Esci dal menu File, il programma 
richiede all'utente se desidera riavviare subito Windows o continuare la sessione di lavoro corrente. Se si 
sceglie l'opzione di riavvio, Windows termina tutti i compiti (task) correnti e si riavvia immediatamente 
utilizzando il driver video personalizzato. In caso contrario, il programma SetRes    termina ed il driver 
video personalizzato verrà utilizzato la prossima volta che si avvia Windows.
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Aiuto
La scelta del comando Aiuto dal    Menu chiama la utilita di Guida del Windows
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Info
La scelta del    commando Info    dal Menu Aiuto mostra alcune informazioni riguardo il programma 
SetRes.
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Deutsch

Dienstprogramm zur Einstellung der Auflösung
Mit dem Dienstprogramm zur Einstellung der Auflösung kann der Benutzer die Anzeigeauflösung, den 
Gebrauch großer und normaler Schriften und, in einigen Fällen, die Zahl der gleichzeitig angezeigten 
Farben festlegen. Darüber hinaus unterstützen bestimmte Graphikchips und Spezialanzeigetreiber-
Konfigurationen die Anzeige von Mauszeigerspuren und Ansichten im Quer- bzw. Hochformat.

Informationen zum Gebrauch der Hilfefunktion erhalten Sie, wenn Sie auf F1 drücken oder die Option 
'Hilfe benutzen' aus dem Hilfemenü wählen.

Themen

Beendenmenü
Hilfemenü
Funktionsmerkmale

International Hilfe



Beendenmenü
Das Beendenmenü enthält einen Befehl, mit dem das Dienstprogramm zur Einstellung der Auflösung 
sofort beendet wird. Wurde eine Option geändert oder der Spezialanzeigetreiber noch nicht installiert, 
wird der Benutzer aufgefordert, entweder Windows sofort neu zu starten oder mit der aktuellen Windows-
Sitzung fortzufahren. Wird die Neustartoption gewählt, versucht Windows, alle Aufgaben sofort zu 
beenden und mit den neuen Auflösungseinstellungen erneut zu starten. Wenn Sie die Neustartoption 
nicht wählen, wird das Dienstprogramm zur Einstellung der Auflösung beendet. Die neuen 
Auflösungseinstellungen werden beim nächsten Start von Windows wirksam. 
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Hilfemenü
Das Hilfemenü enthält Befehle, die eine Hilfesitzung aufrufen und Informationen über die Hardware- und 
Anzeigetreiberumgebung anzeigen.

Weitere Informationen erhalten Sie, wenn Sie den Befehlsnamen des Hilfemenüs auswählen.

Info Zeigt Informationen über das Dienstprogramm zur Einstellung der Auflösung an.

Hilfe Ruft das Hilfefenster für das Dienstprogramm zur Einstellung der Auflösung auf.
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Funktionsmerkmale des Dienstprogramms zur 
Einstellung der Auflösung
Das Dienstprogramm zur Einstellung der Auflösung verfügt über eine Reihe von Funktionsmerkmalen, mit
denen der Benutzer die Anzeigeauflösung, den Gebrauch großer und normaler Schriften und, in einigen 
Fällen, die Zahl der gleichzeitig angezeigten Farben festlegen kann.

Die Anzeige von Mauszeigerspuren und Ansichten im Quer- bzw. Hochformat richtet sich nach dem 
jeweiligen Graphikchipsatz und den verfügbaren Spezialanzeigetreibern.

Die Aktivierung bzw. Deaktivierung der Mauszeigerspur-Funktion wird bei Geräten, die diese Option 
unterstützen, sofort wirksam. Alle anderen gewählten Optionen werden beim nächsten Start von Windows
wirksam, wie aus der folgenden Beschreibung hervorgeht.

Die Spezialanzeigetreiber sind in der Lage, verschiedene Kombinationen aus Anzeigeauflösung und 
gleichzeitigen Farben zu unterstützen. Die Höchstwerte für Auflösung und Zahl der gleichzeitig 
angezeigten Farben werden vom Graphikchipsatz, der Größe des installierten Videospeichers, dem 
Monitortyp und den verfügbaren Spezialanzeigetreibern bestimmt.

Mit Hilfe der Spezialanzeigetreiber können Windows-Versionen ab 3.1 große oder normale Schriften 
verwenden. Die großen Schriften arbeiten mit Anzeigeressourcen von 120 dpi (dots per inch, Punkten pro
Zoll), kleine Schriften dagegen arbeiten mit 96 dpi. Bei der Arbeit mit 120 dpi anstatt von 96 dpi wird die 
physische Größe der Windows-Systemressourcen erhöht. Die großen Schriften können nur gewählt 
werden, wenn die entsprechenden Ressourcen im Windows-Systemverzeichnis installiert worden sind. 
Dies wird normalerweise bei der Installation von Anzeigetreibern mit dem Setup-Programm von Windows 
vorgenommen. Die Großschrift-Ressourcen, die manchmal auch als die 8514-Schriften von Windows 
bezeichnet werden, müssen bereits installiert sein. Windows 3.0 verfügt nicht über die Fähigkeit, die 
Anzeige- oder Schriftressourcen zu ändern.

Durch Auswahl der Schaltfläche 'Abbrechen' im Hauptfenster des Dienstprogramms wird die Sitzung zur 
Einstellung der Auflösung sofort beendet. Alle vorgenommenen Änderungen werden ignoriert.

Durch Auswahl der Schaltfläche 'OK' im Hauptfenster des Dienstprogramms wird die Sitzung zur 
Einstellung der Auflösung sofort beendet, wenn Sie keine Änderungen vorgenommen haben. Wurden 
eine oder mehrere der Einstellungen geändert, wird der Benutzer aufgefordert, entweder Windows sofort 
neu zu starten oder mit der aktuellen Windows-Sitzung fortzufahren. Wird die Neustartoption gewählt, 
versucht Windows, alle Aufgaben sofort zu beenden und mit den neuen Auflösungseinstellungen erneut 
zu starten. Wenn Sie die Neustartoption nicht wählen, wird das Dienstprogramm zur Einstellung der 
Auflösung beendet. Die neuen Auflösungseinstellungen werden beim nächsten Start von Windows 
wirksam.

Wenn der Spezialanzeigetreiber noch nicht als Windows-Anzeigetreiber installiert wurde und die 
Schaltfläche 'OK' aus dem Hauptfenster des Dienstprogramms gewählt wird, oder wenn Sie die Option 
'Beenden' aus dem Dateimenü wählen, erhalten Sie die Aufforderung, entweder Windows sofort neu zu 
starten oder mit der aktuellen Windows-Sitzung fortzufahren. Wird die Neustartoption gewählt, versucht 
Windows, alle Aufgaben sofort zu beenden und unter Verwendung des Spezialanzeigetreibers erneut zu 
starten. Wenn Sie die Neustartoption nicht wählen, wird das Dienstprogramm zur Einstellung der 
Auflösung beendet. Der Spezialanzeigetreiber wird beim nächsten Start von Windows verwendet.
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Hilfe
Durch Auswahl des Befehls Hilfe aus dem Hilfemenü wird das Hilfeprogramm von Windows aufgerufen.
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Info
Durch Auswahl des Befehls Info aus dem Hilfemenü werden Informationen über das Dienstprogramm zur
Einstellung der Auflösung aufgerufen.
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 Español

Utilidad Definir resolución
La utilidad Definir resolución dispone de opciones que permiten al usuario seleccionar la resolución de la 
pantalla, elegir tipos de tipos de letra de distintos tamaños y, en determinadas ocasiones, el número de 
colores que debe mostrar la pantalla simultáneamente. Por otra parte, existen ciertas pastillas de gráficos
y controladores de pantalla cuyas configuraciones admiten el uso de punteros de ratón, facilitan el 
seguimiento de sus movimientos e incluso permiten decidir si la orientación de las páginas en pantalla 
debe ser normal o apaisada.

Para obtener más información relacionada con el uso del sistema de Ayuda, pulse la tecla F1 o elija la 
opción Uso de la Ayuda en el menú Ayuda.

Elementos

Menú Salir     
Menú Ayuda
Funciones

Aiuda Internacional



Menú Salir
El menú Salir contiene un comando que permite abandonar la utilidad Definir resolución de forma 
inmediata. En el caso de que se haya modificado una selección o si el controlador de pantalla 
personalizado no se ha instalado todavía, el programa muestra un mensaje en el que se solicita al 
usuario que indique si desea reinicializar Windows o continuar la sesión actual. Si opta por reinicializar el 
programa, Windows intentará finalizar las tareas que pueda haber en curso para, a continuación volver a 
arrancar y aplicar los nuevos valores de resolución seleccionados. Si no selecciona la opción reinicializar,
la utilidad Definir resolución dejará de ejecutarse; los nuevos valores se aplicarán la próxima vez que 
acceda a Windows.
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Menú Ayuda
Incluye comandos que facilitan el acceso a una sesión del sistema de Ayuda y muestran en pantalla 
información sobre el hardware y el entorno del controlador de pantalla en uso.

Para obtener más información al respecto, seleccione el nombre del comando adecuado del menú 
Ayuda.

Acerca de Muestra información relacionada con la utilidad Definir resolución

Aiuda Abre la ventana de Ayuda correspondiente a la utilidad Definir resolución
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Funciones de la utilidad Definir resolución
Permiten al usuario seleccionar la resolución de la pantalla, el uso de tipos de letra de tamaño normal o 
grande y, en ocasiones, el número de colores que habrán de aparecer en pantalla simultáneamente.

Las funciones de seguimiento del puntero del ratón y la selección de la orientación de las páginas, 
normal o apaisada, vienen determinadas por la pastilla de gráficos que se utilice y los controladores de 
pantalla de vídeo personalizado con que se cuente.

La activación y desactivación de las funciones de seguimiento del puntero del ratón que se realizan 
directamente en los dispositivos tienen efectos inmediatos. Las opciones restantes se activarán la 
próxima vez que acceda a Windows, tal y como se indica más adelante.

Los controladores de pantalla de vídeo personalizado admiten el uso de varias combinaciones de 
resolución de pantalla y colores simultáneos. El número máximo de ambos elementos que los 
controladores pueden tolerar viene determinado por la configuración de la pastilla de gráficos, la cantidad
de memoria de vídeo instalada, el tipo de monitor y los controladores de que pueda disponer.

Los controladores de pantalla de vídeo personalizado permiten a los usuarios de Windows versión 3.1 y 
posteriores el empleo de tipos de letra normal y grande. Los de tamaño grande utilizan recursos de 
pantalla de 120 puntos por pulgada (ppp), mientras que los correspondientes a los de tamaño normal son
de 96 ppp. El empleo de recursos de 120 ppp en lugar de los de 96, incrementa el tamaño físico de los 
recursos del sistema que necesita Windows. Al objeto de facilitar la selección de las opciones para los 
tipos de letra grandes, es conveniente que los recursos adecuados estén instalados en el directorio del 
sistema de Windows. Por lo general, esta tarea se realiza durante la instalación de los controladores de 
vídeo mediante el programa de instalación de Windows, si bien es necesario que los recursos de este 
tipo de letra, al que con frecuencia se denomina fuente 8514 de Windows, se encuentren instalados 
previamente. Por otra parte, cabe destacar que el programa Windows versión 3.0 no dispone de la 
posibilidad de cambiar los recursos de pantalla o de tipos de letra.
 
La selección del botón Cancelar, incluido en la ventana principal de la utilidad, da por finalizada la sesión 
de Definir resolución de forma inmediata. El programa ignorará cualquier selección que se realice a 
continuación.

La selección del botón Aceptar, situado en la ventana principal de la utilidad, dará por finalizada la sesión 
actual de Definir resolución, en el caso de que no se hayan introducido modificaciones. En caso 
contrario, aparecerá en pantalla un mensaje solicitando al usuario que indique si desea reinicializar 
Windows en ese momento o continuar con la sesión en curso. Si opta por reinicializar Windows, el 
programa intentará finalizar todas las tareas que pueda haber en ejecución y, seguidamente, volverá a 
arrancar aplicando la nueva resolución que se haya seleccionado. Si no se selecciona opción alguna, la 
utilidad Definir resolución dejará de ejecutarse y las selecciones no se aplicarán hasta tanto no se 
acceda a Windows de nuevo.

Si el controlador de vídeo personalizado no se ha instalado todavía como el controlador que va a 
emplear Windows y se ha seleccionado el botón Aceptar, contenido en la ventana principal de la utilidad, 
o se ha seleccionado el mandato Salir, en el menú Archivo, la pantalla mostrará un mensaje instando al 
usuario a reinicializar Windows o continuar con la sesión actual. Si opta por reinicializar Windows, el 
programa intentará concluir las tareas en curso y, de forma inmediata, volverá a arrancar y utilizará el 
controlador de vídeo personalizado. Si no se elige la opción de reinicializar, la utilidad Definir resolución 
dejará de ejecutarse. El controlador de pantalla de vídeo personalizado se activará la próxima vez que 
arranque Windows.
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Ayuda
La selección del comando Ayuda, incluido en el menú Ayuda tiene como efecto la activación del sistema 
de Ayuda de Windows.
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Acerca de

La selección del comando Acerca de, incluido en el menú Ayuda permite acceder a información 
relacionada con la utilidad Definir resolución
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Français

Utilitaire Définition de la résolution
L'utilitaire Définition de la résolution permet à l'utilisateur de sélectionner la résolution de l'écran, 
l'utilisation de polices agrandies ou normales et, dans certains cas, le nombre de couleurs simultanément 
affichables. En outre, certaines configurations de circuits graphiques et de gestionnaires d'affichage 
spécifiques supportent la traînée du pointeur de la souris et/ou le choix de l'orientation d'affichage 
portrait/paysage.

Pour obtenir des informations sur l'utilisation de l'aide, appuyez sur F1 ou choisissez Utilisation de l'aide 
du menu Aide.

Rubriques

Menu Quitter
Menu Aide
Fonctions

Aide International



Menu Quitter
Le menu Quitter comprend une commande qui termine immédiatement la session de Définition de la 
résolution. Si des modifications ont été effectuées ou si le gestionnaire d'affichage spécifique n'est pas 
encore installé, le programme propose à l'utilisateur de redémarrer Windows immédiatement ou de 
poursuivre la session en cours. Si l'option de redémarrage immédiat est choisie, Windows tente d'arrêter 
les tâches en cours et de redémarrer immédiatement avec les nouvelles résolutions d'écran. Si l'option de
redémarrage immédiat n'est pas choisie, l'utilitaire Définition de la résolution se termine et les nouvelles 
sélections de résolution seront effectives à partir de la prochaine session de Windows.
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Menu Aide

Le menu Aide comprend une commande qui appelle une session d'aide et affiche l'environnement de 
gestionnaire d'affichage et matériel.

Pour obtenir des informations complémentaires, sélectionnez la commande de menu Aide.

A propos Affiche des information sur l'utilitaire Définition de la résolution

Aide Affiche la fenêtre d'aide de l'utilitaire Définition de la résolution

Sommaire 



Fonctions de définition de la résolution
L'ensemble des fonctions de l'utilitaire Définition de la résolution permet à l'utilisateur de sélectionner la 
résolution de l'écran, l'utilisation de polices agrandies ou normales et, dans certains cas, le nombre de 
couleurs simultanément affichables. 

La traînée du pointeur de la souris et/ou le choix de l'orientation d'affichage portrait/paysage sont 
déterminés par les capacités des circuits de la carte graphique et par les gestionnaires d'affichage 
disponibles.

L'activation ou la désactivation de la traînée du pointeur de la souris est opérationnelle avec les cartes qui
supportent cette option et prend effet immédiatement. Toutes les autres options sont activées au prochain
démarrage de Windows, comme indiqué ci-après.

Les gestionnaires d'affichage spécifiques sont capables de supporter différentes combinaisons de 
résolutions d'écran et de nombres de couleurs simultanées. La résolution maximale et le nombre de 
couleurs simultanées sont déterminées par les capacités des circuits de la carte graphique, la quantité de
mémoire vidéo installée, le type de moniteur et les gestionnaires d'affichage spécifiques disponibles.

Les gestionnaires d'affichage spécifiques permettent à Windows 3.1 versions et supérieures d'utiliser des 
polices agrandies ou normales. Les grandes polices utilisent des ressources écrans de 120 points par 
pouces (ppp ou dpi pour "dot per inch"). Les petites polices utilisent des ressources écrans de 96 ppp. 
L'utilisation de ressources de 120 ppp, par rapport à 96 ppp, augmente la taille physique des ressources 
système Windows. Pour que l'option grandes polices soit disponible, les ressources correspondantes 
doivent être installées dans le répertoire système de Windows. Cette opération est en générale assurée 
dans le cadre de l'installation des gestionnaires d'affichage par le programme d'installation de Windows. 
Les ressources de grande police, parfois appelées polices Windows 8514, doivent être installées. 
Windows 3.0 ne permet pas le changement des ressources de police ou d'écran.

La sélection du bouton Annuler dans la fenêtre principale de l'utilitaire termine immédiatement la session 
de Définition de la résolution. Toutes les sélections sont ignorées.

La sélection du bouton OK dans la fenêtre principale de l'utilitaire termine immédiatement la session de 
Définition de la résolution si aucune modification n'a été effectuée. Si des modifications ont été 
effectuées, le programme propose à l'utilisateur de redémarrer Windows immédiatement ou de poursuivre
la session en cours. Si l'option de redémarrage immédiat est choisie, Windows tente d'arrêter les tâches 
en cours et de redémarrer immédiatement avec les nouvelles résolutions d'écran. Si l'option de 
redémarrage immédiat n'est pas choisie, l'utilitaire Définition de la résolution se termine et les nouvelles 
sélections de résolution seront effectives à partir de la prochaine session de Windows.

Si le gestionnaire d'affichage spécifique n'a pas encore été installé comme gestionnaire d'affichage 
Windows et que le bouton OK est sélectionné dans la fenêtre principale de l'utilitaire ou que l'option 
Quitter est sélectionnée dans le menu Fichier, le programme propose à l'utilisateur de redémarrer 
Windows immédiatement ou de poursuivre la session en cours. Si l'option de redémarrage immédiat est 
choisie, Windows tente d'arrêter les tâches en cours et de redémarrer immédiatement avec les nouvelles 
résolutions d'écran. Si l'option de redémarrage immédiat n'est pas choisie, l'utilitaire Définition de la 
résolution se termine et les nouvelles sélections de résolution seront effectives à partir de la prochaine 
session de Windows.
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Aide
Le choix de la commande Aide du menu Aide appelle l'aide de Windows.

Sommaire 



A propos
Le choix de la commande A propos du menu Aide affiche des informations sur l'utilitaire Définition de la 
résolution
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Nederlands

Resolutie instellen (hulpprogramma)
Met het hulpprogramma "Resolutie instellen" kunt u de schermresolutie, het gebruik van grote of normale 
schermfonts en, in sommige gevallen, het aantal kleuren voor gelijktijdige weergave selecteren. 
Bovendien worden door sommige grafische coprocessors en beeldscherm-stuurprogramma's speciale 
functies ondersteund voor de muispijl en de weergave-richting (staand of liggend).

Druk op F1 voor de Help-informatie of kies Help uit het Helpmenu.

Onderwerpen

Afsluitenmenu
Helpmenu
Functies

Internationaal Help



Afsluitenmenu

Het Afsluitenmenu bevat een opdracht waarmee u het hulpprogramma "Resolutie instellen" direct kunt 
verlaten. Als u een selectie hebt gewijzigd of als een speciaal schermstuurprogramma nog niet is 
geïnstalleerd, verschijnt het bericht dat u Windows hetzij direct moet herstarten, hetzij door kunt gaan met
de huidige Windows-sessie. Als u kiest voor herstarten, zal Windows alle actieve vensters sluiten en 
direct opnieuw worden gestart volgens de nieuwe resolutie-instellingen. Als u niet voor herstarten kiest 
wordt het hulpprogramma afgesloten. De nieuwe resolutie-instellingen worden pas actief wanneer u 
Windows de volgende keer start.

Index



Help-menu 

Het Help-menu bevat opdrachten om de hulpinformatie en gegevens over de apparatuur en het 
schermstuurprogramma op te roepen.

Selecteer de opdrachtnaam Help voor meer informatie.

Info Geeft informatie over het hulpprogramma "Resolutie instellen .

Help Opent het helpvenster bij "Resolutie instellen
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Resolutie instellen: Functies
Met de functies van het hulpprogramma "Resolutie instellen" kunt u de schermresolutie, het gebruik van 
grote of normale schermfonts en in sommige gevallen het aantal kleuren voor gelijktijdige weergave 
kiezen.

Muispijl-markering en staande of liggende weergave-richting zijn afhankelijk van de grafische coprocessor
en het beschikbare schermstuurprogramma.

In- of uitschakeling van de muispijl-markering op apparatuur die deze ondersteunen wordt direct actief. 
Voor activering van alle andere geselecteerde opties moet eerst Windows opnieuw gestart worden (zie 
hieronder).

Speciale schermstuurprogramma's ondersteunen diverse combinaties van schermresoluties en aantallen 
gelijktijdig weergegeven kleuren. De maximum resolutie en het maximum aantal kleuren zijn afhankelijk 
van de grafische coprocessor, het geïnstalleerde weergavegeheugen, het type beeldscherm en het 
beschikbare schermstuurprogramma.

Met de speciale schermstuurprogramma's kan Windows 3.1 (of hoger) grote of normale schermfonts 
gebruiken. Grote fonts gebruiken 120 beeldpunten per inch (dpi) en de kleinere fonts gebruiken 96 dpi. 
Door het gebruik van 120 dpi schermfonts wordt de fysieke grootte van het Windows-systeem groter. Om 
het gebruik van de grote fonts te kunnen selecteren moeten de grote schermfonts geïnstalleerd zijn in de 
systeem-directory van Windows. Dit gebeurt meestal tijdens het installeren van schermstuurprogramma's 
met behulp van Windows Setup. De grote schermfonts, ook wel Windows 8514-fonts genoemd, moeten 
eerder geïnstalleerd zijn. Voor Windows 3.0 is het niet mogelijk een andere grootte te kiezen voor de 
schermfonts.

Als u in het hoofdvenster op Annuleer klikt, wordt het hulpprogramma direct verlaten. Eventuele 
wijzigingen worden niet doorgevoerd.

Als u in het hoofdvenster op OK klikt, wordt het hulpprogramma direct verlaten als u geen wijzigingen 
hebt aangebracht.Als één of meer opties zijn gewijzigd, wordt u gevraagd of u Windows direct opnieuw 
wilt opstarten of wilt doorgaan met de huidige Windows-sessie. Kiest u voor herstarten, dan zal Windows 
proberen alle taken af te sluiten en direct opnieuw te starten volgens de nieuwe resolutie-instellingen. Als 
u niet voor herstarten kiest, wordt het hulpprogramma "Resolutie instellen" verlaten. De nieuwe resolutie-
instellingen worden pas actief als u Windows opnieuw opstart.

Als geen speciaal schermstuurprogramma is geïnstalleerd voor Windows en u klikt op OK in het 
hoofdvenster, of u kiest Stoppen uit het Bestandsmenu, wordt u gevraagd of u Windows direct wilt 
herstarten of dat u wilt doorgaan met de huidige Windows-sessie. Kiest u voor herstarten, dan zal 
Windows proberen alle taken af te sluiten en direct opnieuw te starten met het nieuwe 
schermstuurprogramma. Als u niet voor herstarten kiest, wordt het hulpprogramma "Resolutie instellen" 
verlaten. Het nieuwe schermstuurprogramma wordt pas gebruikt als u Windows opnieuw opstart.
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Help
Kies de opdracht Help uit het Help-menu om de hulpinformatie voor Windows op te roepen.
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Info
Kies de opdracht Info uit het Help-menu voor informatie over het hulpprogramma "Resolutie instellen

Index



Svenska

Välj upplösning
Med funktionen Välj upplösning kan du markera bildskärmens upplösning, välja mellan stora och normala 
teckensnitt och, i vissa fall, antalet samtidiga färger. Dessutom stöder en del grafikkort och anpassade 
drivrutiner för video musspårning och visning liggande och/eller stående.

Mer information om att använda Hjälp får du om du trycker på F1 eller väljer Använda Hjälp på Hjälp-
menyn.

Avsnitt

Avsluta-menyn
Hjälp-menyn
Funktioner

Hjälp Internationell 



Avsluta-menyn
På Avsluta-menyn finns ett kommando som omedelbart avslutar funktionen Välj upplösning. Om du har 
gjort ändringar, eller om den anpassade drivrutinen för bildskärm inte har installerats, uppmanas du att 
omedelbart starta om Windows eller fortsätta med den aktuella Windows-sessionen. Om du väljer 
alternativet Starta om försöker Windows avsluta alla uppgifter och starta om med de nya 
upplösningsalternativen. Om du inte har valt alternativet Starta om avslutas funktionen Välj upplösning. 
De markerade upplösningsalternativen får effekt nästa gång du startar Windows.
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Hjälp-menyn
Hjälp-menyn innehåller kommandon för hjälpavsnitt som visar utrustning och drivrutiner.

Markera kommandot på Hjälp-menyn för mer information.

Om Ger information om funktionen Välj upplösning

Hjälp Öppnar hjälpfönstret till funktionen Välj upplösning.
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Välj upplösningsfunktioner

Med funktionen Välj upplösning kan du markera bildskärmens upplösning, välja mellan stora och normala 
teckensnitt och, i vissa fall, antalet samtidiga färger.

Musspårning och visning liggande och/eller stående bestäms av grafikkortet och tillgängliga anpassade 
drivrutiner för bildskärm.

Aktivering eller desaktivering av musspårningsfunktionen för enheter som stöder funktionen får 
omedelbara resultat. Övriga alternativ finns tillgängliga nästa gång du startar Windows, vilket beskrivs 
nedan.

De anpassade drivrutinerna för bildskärm stöder olika kombinationer av skärmupplösningar och samtidiga
färger. Den maximala upplösningen och antalet samtidiga färger bestäms av grafikkortet, mängden 
installerat videominne, bildskärmstyp och tillgängliga drivrutiner för bildskärm.

Med anpassade drivrutinerna för bildskärm kan Windows 3.1 och högre versioner använda stora eller 
normala teckensnitt. Stora teckensnitt använder 120 dpi (punkter per tum) medan små använder 96 dpi. 
Alternativet 120 dpi ökar den fysiska storleken på Windows systemresurser. För att du ska kunna markera
alternativet stora teckensnitt måste du installera resurserna i Windows systemkatalog. Det gör du normalt 
när drivrutinerna för bildskärm installeras med Windows installationsprogram. Resurserna, som ibland 
kallas Windows 8514-teckensnitt, måste vara installerade sedan tidigare. Med Windows 3.0 kan du inte 
ändra resurser för bildskärm eller teckensnitt.

Om du väljer knappen Avbryt i funktionens huvudfönster avslutas omedelbart sessionen Välj upplösning. 
Alla markeringar annulleras.

Om du väljer knappen OK i funktionens huvudfönster och inte har gjort några ändringar avslutas 
omedelbart sessionen Välj upplösning. Om du har gjort ändringar uppmanas du att omedelbart starta om 
Windows eller fortsätta med den aktuella Windows-sessionen. Om du väljer alternativet Starta om 
försöker Windows avsluta alla uppgifter och starta om med de nya upplösningsalternativen. Om du inte 
väljer alternativet Starta om avslutas funktionen Välj upplösning. De markerade upplösningsalternativen 
får effekt nästa gång du startar Windows.

Om du inte har installerat den anpassade drivrutinen för bildskärm i Windows och markerat knappen OK i 
funktionens huvudfönster, eller om du valt Avsluta på Arkiv-menyn, uppmanas du att antingen omedelbart 
starta om Windows eller fortsätta med den aktuella sessionen. Om du har valt Starta om försöker 
Windows avsluta alla uppgifter och omedelbart starta om med den anpassade drivrutinen för bildskärmen.
Om du inte har valt alternativet Starta om avslutas funktionen Välj upplösning. Den anpassade drivrutinen
för bildskärm används nästa gång du startar Windows.
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Hjälp
Om du väljer Hjälp på Hjälp-menyn aktiveras Windows hjälpfunktion.

Index



Om
Om du väljer Om på Hjälp-menyn visas information om funktionen Välj upplösning.
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UK English

Set Resolution Utility
The Set Resolution utility allows the user to select the screen resolution, the use of large and normal 
fonts, and, in some instances, the number of simultaneous screen colours.    In addition, certain graphics 
chips and custom video display driver configurations support mouse pointer trails and/or landscape or 
portrait viewing orientations.

For information on how to use Help, press F1 or choose Using Help from the Help Menu.

Items

Exit Menu
Help Menu
Features

International Help



Exit Menu
The Exit menu includes a command that immediately exits the Set Resolution utility.    If a selection has 
been modified or if the custom video display driver has not yet been installed, the user will be prompted to
either restart Windows immediately or continue with the current Windows session.    If the restart option is 
selected, Windows will attempt to terminate all tasks and immediately restart using the new resolution 
selections.    If the restart option is not selected, the Set Resolution utility will terminate.    The new 
resolution selections will take effect the next time Windows is started.
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Help Menu
The Help menu includes commands that invokes a Help session and displays the hardware and display 
driver environment.

For more information, select the Help menu command name.

About Shows information about the Set Resolution utility.

Help Retrieves the Help window for the Set Resolutionutilty
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Set Resolution Features
The Set Resolution utility feature set allows the user to select the screen resolution, the use of large and 
normal fonts, and, in some instances, the number of simultaneous screen colours.

Mouse pointer trails and landscape/portrait viewing orientation are determined by the graphics chip set 
and the available custom video display drivers.

Enabling or disabling the mouse pointer trails function on devices which support the mouse trails option 
will have immediate results.    All other selected options are enabled the next time Windows is restarted, 
as discussed below.

The custom video display drivers are capable of supporting various combinations of screen resolutions 
and simultaneous colours.    The maximum resolution and number of simultaneous colours are 
determined by the graphics chip set, the amount of installed video memory, the monitor type, and the 
available custom video display drivers.

The custom video display drivers allow versions of Windows release 3.1 and above to utilize large or 
normal fonts.    Large fonts utilize screen resources of 120 dots per inch (dpi).    Small fonts utilize screen 
resources of    96 dpi.    The use of 120 dpi rather than 96 dpi resources will increase the physical size of 
the Windows system resources.    In order for the large fonts option to be selectable, the large font 
resources must have been installed in the Windows system directory.    This is usually accomplished while
installing video drivers using the Windows Setup program.    The large font resources, sometimes referred
to as the Windows 8514 fonts, must have been previously installed.    Windows release 3.0 does not 
provide the facility to change the screen or font resources.

Selecting the Cancel button from the utility's main window will immediately terminate the Set Resolution 
session.    Any selections will be disregarded.

Selecting the OK button from the utility's main window will immediately terminate the Set Resolution 
session if no modifications have been made.    If one or more modifications have been changed the user 
will be prompted to either restart Windows immediately or continue with the current Windows session.    If 
the restart option is selected, Windows will attempt to terminate all tasks and immediately restart using 
the new resolution selections.    If the restart option is not selected, the Set Resolution utility will terminate.
The new resolution selections will take effect the next time Windows is started.

If the custom video display driver has not yet been installed as the Windows display driver and the OK 
button is selected from the utility's main window or Exit is selected from the File Menu, the user will be 
prompted to either immediately restart Windows or continue with the current Windows session.    If the 
restart option is selected, Windows will attempt to terminate all tasks and immediately restart using the 
custom video display driver.    If the restart option is not selected, the Set Resolution utility will terminate.    
The custom video display driver will be used the next time Windows is started.
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Help
Choosing the Help command from the Help menu will invoke the Windows' Help utility.
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About
Choosing the About command from the Help menu displays information about the Set Resolution utility.
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